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FCC Class B Notice

This device complies with Part 15 of the FCC Rules. Operation is subject to the follow-
ing two conditions:

1. This device may not cause harmful interference.

2. This device must accept any interference received, including interference that may
cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful interference to
radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

* Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

* Consult the dealer or an experienced radio/television technician for help.

Foil Shielded Cables:

Connections between the IdeaShareTM board and computer and other devices must be
made using foil shielded cables in order to maintain compliance with FCC radio fre-
quency emission limits.

Modifications:

Any modifications made to this device that are not approved by General Binding Cor-
poration may void the authority granted to the user by the FCC to operate this equip-
ment.

Canada Class B Notice - Avis Canada, Classe B

This Class B digital apparatus complies with Canadian ICES-3.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Chapter 1

The Quartet® IdeaShare® Board...

The Quartet IdeaShare Board uses eBeamTM electronic imaging technology to capture
notes and images. Using the Quartet IdeaShare Board, information can be saved to a
PC or Mac, directly printed with the touch of a button (no computer needed), or

beamed to any PDA handheld with PalmTM OS.  Using eBeam Software, you can also
share sessions with remote participants live over the Internet/intranet and create
interactive presentations with the virtual touchscreen capability. The Quartet
IdeaShare Board is shown below in the three possible use configurations available.

Copyboard mode
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Software Features

Additional popular software features:

• Share whiteboard drawings in real time over the intranet/Internet in an eBeam 
meeting. Microsoft NetMeeting can also be used to share meetings.

• Replay, edit, and annotate images from your meetings and attach them to email 
messages.

• Import images, files, or even a snapshot of your own computer screen into the 
background of the current meeting for all users to see and annotate.

• Use eBeam Software with a projector to turn your whiteboard into a virtual 
touchscreen.

• A "wake up" or Autolaunch feature automatically wakes up the eBeam Software 
and begins to record once an electronic pen touches the whiteboard.

• eBeam Software automatically checks for software updates to make sure you 
always have the latest features.

The Software Reference Guide is included for quick, easy-to-understand instructions
on how to use the main software features.  The Software Reference Guide is very
handy when your Quartet IdeaShare Board is shared by many users.  Simply leave the
guide next to the product so everyone can be comfortable with the software and begin
taking advantage of this collaboration tool.  For more detailed instructions on how to
use all of the many software features, refer to the Help menu in the software.
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Chapter 2

Set Up and Use The Quartet IdeaShare Board

The Quartet IdeaShare system is shown in the Figure A below.

Figure A

Installing the Quartet IdeaShare Board 
Please refer to the Quick Set Up Guide for instructions on mounting the Quartet
IdeaShare Board onto a wall and setting up the system. The Set Up Guide describes
how to set up the system as a Digital Whiteboard.

Electronic pens Electronic eraser

Quartet® IdeaShareTM Board
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To learn how to direct print and beam to a PDA, please see “Using the Quartet
IdeaShare Board as a Copyboard (Printer/PDA Only)” on page 4. For instructions on
how to create interactive presentations, see “Using the Quartet IdeaShare Board as a
Virtual Touchscreen (Projector)” on page 11.

A mobile stand to allow the Quartet IdeaShare Board to be moved from room to room
is available. For information on the mobile stand, please contact your office products
dealer and ask for Quartet IdeaShare Board Stand (product # Q8000S).

Using the Quartet IdeaShare Board
The following sections describe the different ways to use the Quartet IdeaShare Board:

• As a copyboard to direct print and beam to a PDA (page 4).

• As a digital whiteboard to save and share (page 8).

• As a virtual touchscreen to create interactive presentations (page 11).

Using the Quartet IdeaShare Board as a Copyboard (Printer/PDA Only)

Figure B

Refer to Figure B for the layout of the Quartet IdeaShare Board when used as a
copyboard, and “Terminology” on page 15 for a list of terms and definitions for terms
used throughout the User Manual.  

In copyboard mode, the Quartet IdeaShare Board is a standalone unit connected only
to a printer.  Captured data is stored within the system and can either be printed to
the connected printer, or beamed to a supported PDA device through the IR port.
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Figure C

As shown in Figure C, there are three buttons on the Quartet IdeaShare Board tray
used specifically for copyboard mode:

• Clear - Clears all data from the system and starts a new page.  Information 
written on the whiteboard needs to be erased.  We recommend using a standard 

whiteboard eraser (Quartet GhostDuster eraser, included) for erasing the entire 
whiteboard.  The electronic eraser should only be used for making edits during a 
session.

• Beam - When the system has data, beams all data stored in the system as a 
single page to a supported PDA. A list of supported PDA’s can be found on the 
Quartet IdeaShare website at www.GBCOffice.com. When the system does not 
have data, pressing the Beam button sends an information page to the PDA that 
describes where to find the PDA software for use with the Quartet IdeaShare 
Board. Software for supported PDA’s can be found on the Quartet IdeaShare Board 
itself, and the Quartet IdeaShare website at www.GBCOffice.com. 

To load the eBeam Viewer application, point the IR window of your PDA device 
towards the IR window of the Quartet IdeaShare Board. Press and hold down the 
Beam button for 2 seconds. After a moment the eBeam Viewer application will load 
to your PDA.

Power LED

Status LED

IR Port

Beam

Print

Clear
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• Print - When the system has data, prints all data stored in the system as a single 
page to the connected printer. When the system does not have data, prints a test 
page to the printer that describes the different LED status codes for the Quartet 
IdeaShare Board. A list of supported printers can be found on the Quartet 
IdeaShare website at www.GBCOffice.com.   

Note: Copyboard buttons (Clear, Beam, and Print as described below) operate
differently when eBeam Software is connected to the Quartet IdeaShare Board. When
a computer with eBeam Software running is connected to the Quartet IdeaShare
Board, the system operates as either a Digital Whiteboard  (see “Using the Quartet
IdeaShare Board as a Digital Whiteboard (Computer)” on page 8), or as a virtual
touchscreen  (see “Using the Quartet IdeaShare Board as a Virtual Touchscreen
(Projector)” on page 11).

To use the Quartet IdeaShare Board in copyboard mode:

1. Set up the electronic pens and electronic eraser as shown in the Quick Set Up 
Guide.

2. Plug the USB cable’s USB A connector to the appropriate USB port located on the 
underside of the Quartet IdeaShare Board tray as shown in Figure D and plug the 
USB B connector to the printer.

Figure D

USB Port
(To Printer)
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3. Make sure that the power is on both for the Quartet IdeaShare Board and the 
printer. The right power LED should be green.  Press the Clear button on the 
Quartet IdeaShare Board to make sure that there is no data in the system.

4. Press the Print button on the Quartet IdeaShare Board to print a test page to the 
printer.  The test page displays a list of the possible status LED codes (the status 
LEDs are located directly above the buttons), and the meaning of each code. The 
following table describes all LED codes. The right LED is normally green, and shows 
that the system is turned on.  The left LED indicates the different possible 
condition codes.

Note: A list of supported printers can be found on the Quartet IdeaShare website 
at www.ideashare.com. 

5. If you have a supported PDA, point the IR port of the PDA towards the IR port of 
the Quartet IdeaShare Board (see Figure B on page 4). Software for supported 
PDA’s can be found on the Quartet IdeaShare website.

Note: A list of supported PDA’s can be found on the Quartet IdeaShare website at 
www.GBCOffice.com. 

6. Press the Beam button.  This will beam a note to your PDA that describes where to 
find the PDA software for use with the Quartet IdeaShare Board. Software for 
supported PDA’s can be found on the Quartet IdeaShare Board itself, and the 
Quartet IdeaShare website at www.GBCOffice.com. 

Left LED Description

Off No data in the system.  System is ready.

Rapid Blinking Green Recording data.  An electronic pen or electronic eraser is 
being used on the whiteboard.

Slow Blinking Green Data is contained in the system.

Alternating Green/Amber Printing to the connected printer.

Blinking Amber Beaming to a supported PDA over the IR port.

Solid Amber Communicating with a connected computer.  Copyboard 
functions are not available.

Solid Red Connection Error.

Slow Blinking Red Printing Error.  Check that the printer is on, is connected 
to the Quartet IdeaShare Board, and has paper.
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To load the eBeam Viewer application, point the IR window of your PDA device 
towards the IR window of the Quartet IdeaShare Board. Press and hold down the 
Beam button for 2 seconds. After a moment the eBeam Viewer application will load 
to your PDA.

7. Begin writing on the Quartet IdeaShare Board using the electronic pens and 
electronic eraser. Notes and images drawn using the electronic pens and eraser 
are stored in the system.

• Press the Print button to print directly to the attached printer. You can press 
the Print button at any time during your copyboard session.

• Press the Beam button to beam to a supported PDA.  You can press the Beam 
button at any time during your copyboard session.

• Press the Clear button when you erase the entire board and wish to begin a 
new board. Be cautious when pressing this button. Make sure you have first 
printed or beamed the data.  Once the Clear button has been pressed, the 
data cannot be retrieved. 

• Information written on the whiteboard needs to be erased after the Clear 
button has been pressed.  We recommend using a standard whiteboard eraser 

(Quartet GhostDuster eraser, included) for erasing the entire whiteboard.  
The electronic eraser should only be used for making edits during the session.

Using the Quartet IdeaShare Board as a Digital Whiteboard (Computer)

Figure E
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Refer to Figure E for the layout of the Quartet IdeaShare Board when used in
whiteboard mode, and “Terminology” on page 15 for a list of terms and definitions for
terms used throughout the Users Manual.    

In whiteboard mode, the Quartet IdeaShare Board  is connected to a computer and the
computer uses eBeam Software.  In whiteboard mode, notes and images that you
draw on the whiteboard are captured electronically, in color, in real time, and available
for storage and display both locally and remotely through your local intranet or the
Internet.

See “Using eBeam Software with the Quartet IdeaShare Board” on page 15 for more
information about using the software.

To use the Quartet IdeaShare Board as a digital whiteboard:

1. Set up the electronic pens, the electronic eraser, and the software as shown on the 
Quick Set Up Guide.

2. Plug the USB cable’s USB A connector to the computer, and the USB B connector to 
the appropriate USB port  located on the underside of the Quartet IdeaShare Board 
tray. See Figure F.

Figure F

USB Port
(from Computer)
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3. If you are using a printer, the printer should be connected to your computer. 

4. Make sure that the power is on both for the Quartet IdeaShare Board and your 
computer. The right power LED on the Quartet IdeaShare Board should be green. 

5. Launch the software on your computer, and make sure that you are in whiteboard 
mode. To make sure you are in whiteboard mode.

• PC: Open the eBeam system tray menu or click the status icon in the top right 
corner of the Whiteboard mode application window and select “Capture from 
Whiteboard”.

• Macintosh OS 10: Open the eBeam System Setting dialog from the eBeam 
docklet icon.  Select “Whiteboard mode”.

6. Begin writing on the Quartet IdeaShare Board using the electronic pens and 
electronic eraser. Notes and images drawn using the electronic pens and eraser 
are stored in your computer. See “Using eBeam Software with the Quartet 
IdeaShare Board” on page 15 for more information about using the software.

When you are using the Quartet IdeaShare Board in digital whiteboard mode, the
three buttons on the Quartet IdeaShare Board tray are used in the following manner:

• Clear - Starts a new Active Page in eBeam Software in the current meeting. The 
data written on the whiteboard is saved in eBeam Software as the previous page in 
the meeting.  Information written on the whiteboard needs to be erased.  

Note: We recommend using a standard whiteboard eraser (Quartet GhostDuster 
eraser, included) for erasing the entire whiteboard.  The electronic eraser should 
only be used for making edits during a session.

• Beam - This button does not work when eBeam Software is connected to the 
Quartet IdeaShare Board. Beaming to a supported PDA can only be done in 
copyboard mode.  See “Using the Quartet IdeaShare Board as a Copyboard 
(Printer/PDA Only)” on page 4.

• Print - Prints the currently displayed page in eBeam Software to a printer 
connected to the computer running eBeam Software. When eBeam Software is 
connected to the Quartet IdeaShare Board, whiteboard data cannot be printed 
directly to a printer attached to the Quartet IdeaShare Board. Direct printing can 
only be done in copyboard mode.  See “Using the Quartet IdeaShare Board as a 
Copyboard (Printer/PDA Only)” on page 4.

Note: IdeaShare Board buttons (Clear, Beam, and Print as described below) operate
differently when eBeam Software is connected to the Quartet IdeaShare Board. When
a computer with eBeam Software running is connected to the Quartet IdeaShare
Board, the system operates as either a Digital Whiteboard  (see “Using the Quartet
IdeaShare Board as a Digital Whiteboard (Computer)” on page 8), or as a virtual
Page 10 Set Up and Use The Quartet IdeaShare Board



touchscreen  (see “Using the Quartet IdeaShare Board as a Virtual Touchscreen
(Projector)” on page 11).

eBeam Software’s meeting application or Microsoft NetMeetingTM can be used in white-
board mode or virtual touchscreen mode to share information on the Quartet
IdeaShare Board over the intranet/Internet with remote meeting participants. Please
see the Software Reference Guide for instructions on sharing or joining meetings.

Using the Quartet IdeaShare Board  as a Virtual Touchscreen (Projector)

Figure G

Refer to Figure G for the layout of the Quartet IdeaShare Board when used in
projection mode, and “Terminology” on page 15 for a list of terms and definitions used
throughout the User Manual.

In virtual touchscreen mode, the Quartet IdeaShare Board functions as your computer
desktop.  Connect both the Quartet IdeaShare Board and a projector to your
computer.  The projector displays your computer desktop onto the whiteboard and the
Quartet IdeaShare Board detects when you touch the board, allowing an electronic pen
(using the plastic stylus insert) to act as a virtual mouse used to control your
computer’s desktop.

In virtual touchscreen mode, you can operate your computer directly from the
whiteboard.  You can open, work in, and close applications, draw freehand in painting
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and drawing applications, or you can operate the eBeam meeting application directly
from the whiteboard.

To use the Quartet IdeaShare Board in virtual touchscreen mode:

1. Set up a single electronic pen with the plastic stylus insert, and the software as 
shown in the Quick Set Up Guide. The plastic stylus insert looks exactly like a dry-
erase marker, except it is all plastic and contains no ink.

2. Plug the USB cable’s USB A connector to the computer, and the USB B connector to 
the appropriate USB port  located on the underside of the Quartet IdeaShare Board 
tray. See Figure H.

Figure H

3. Set up your projector, connecting it to your computer as you normally would.

4. Make sure that the power is on for the Quartet IdeaShare Board, your computer, 
and the projector. When the Quartet IdeaShare Board is powered on, the right 
power LED is green.

5. Aim and focus the projector as near the center of the Quartet IdeaShare Board as 
possible. Make sure that the entire projected image is on the surface of the 

USB Port
(from Computer)
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IdeaShare Board. Eliminate keystoning as much as possible.

6. Launch eBeam Software on your computer, and make sure that you are in 
projection mode.  

7. You will also need to calibrate.  See “Projection/Virtual Touchscreen Mode” on 
page 21. To make sure that you are in projection mode:

• PC: Open the eBeam system tray menu or click the status icon in the top right 
corner of the Whiteboard mode application window and select and select “Use 
With Projector”

• Macintosh OS 10: Open the eBeam System Setting dialog from the eBeam 
docklet icon.  Select “Projection mode”.

8. Begin using the Quartet IdeaShare Board as a virtual touchscreen. Click or double-
click applications to open them, move files, draw in paint programs, or share a 
meeting using the eBeam meeting application.  Anything that you can do with the 
mouse attached to your computer, you can do at the Quartet IdeaShare Board 
using the electronic pen and stylus.

Note: The Print, Clear, and Beam buttons on the Quartet IdeaShare Board do not
function when  the Quartet IdeaShare Board is in Virtual Touchscreen/Projection mode.

eBeam Software’s meeting application or Microsoft NetMeetingTM can be used in white-
board mode or virtual touchscreen mode to share information on the Quartet
IdeaShare Board over the intranet/Internet with remote meeting participants. Please
see the Software Reference Guide for instructions on sharing or joining meetings.
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Chapter 3

Using eBeam Software with the Quartet IdeaShare Board

eBeam Software is provided with the Quartet IdeaShare Board.

Terminology

Commonly used terms are described below:

• Active Page: In whiteboard mode, the active page is the page that currently 
displays data as it is written on the whiteboard.

• Calibration: Calibration is a process that defines the width and height of the 
Image Area, as well as the accurate placement of each captured point within the 
software window. The whiteboard area must always be calibrated to ensure that 
the electronic pen position is properly detected. After calibration, for each point 
that is tapped, the point is placed in the software window relative to the calibration 
points.  The software knows that the point must be within the calibrated width and 
height range, or the point is not valid and is thrown out.  The software also uses 
the calibrated width and height to place the point within the coordinate system in 
the software window.

• Flipchart Mode: eBeam Software has three modes: whiteboard, projection, and 
flipchart modes. Flipchart mode is whiteboard mode for a flipchart. Flipchart mode 
is used with the flipchart clip that is shipped with Quartet Portable IdeaShare. Flip-
chart mode does not work with the IdeaShare Board system.

• Image Area:  The Image Area of the whiteboard is the area of the whiteboard 
where the electronic pen strokes you make are captured by the Quartet IdeaShare 
Board and transferred into the eBeam Software window.  The Image Area is deter-
mined by the placement of the receivers, and the software calibration. The Quartet 
IdeaShare Board receivers are located in the left side of the boards frame.

• Projection Mode or Virtual Touchscreen mode: eBeam Software has three 
modes: digital whiteboard, virtual touchscreen, and flipchart modes. Virtual 
touchscreen mode (also known as projection mode) is when Quartet IdeaShare 
Board, your computer, and a projector are all used together to make your 
whiteboard a touchscreen.  Quartet IdeaShare Board and the projector plug in to 
your computer.  The projector displays your computer desktop onto the 
whiteboard and Quartet IdeaShare Board detects when you touch, allowing any 
electronic pen (using the plastic stylus insert) to act as a virtual mouse. 

• Whiteboard Mode: eBeam Software has three modes: digital whiteboard, virtual 
touchscreen, and flipchart modes. Whiteboard mode is when the Quartet 
IdeaShare Board acts as a whiteboard recorder; recording data as it is written on 
the whiteboard and displaying that data in the eBeam Software application 
window.
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Software Installation & First Time Use

This chapter describes how to set up and use eBeam Software.

1. Set up the Quartet IdeaShare Board as described in the included Quick Set Up 
Guide.

2. Insert the software CD into the CD-ROM drive on your computer. The installer 
(Macintosh or PC) will start up automatically. If the installer does not start up 
automatically, browse to your CD-ROM drive and select the setup program. Follow 
all on-screen directions.

Note: The latest version of eBeam Software can be downloaded from the Quartet 
IdeaShare website at www.ideashare.com.

3. Launch eBeam Software. The first time eBeam Software opens, it opens in 
Whiteboard mode (see “Terminology” on page 15).

Note:  If eBeam Software was unable to autodetect the Quartet IdeaShare Board, 
see “Troubleshooting” on page 23.

4. Select the mode you wish to use. The three possible modes (described in 
“Terminology” on page 15) are: 

• Whiteboard mode

• Flipchart mode - Available only with Quartet Portable IdeaShare.

• Projection mode

Note: In the PC version of eBeam Software, the first time you launch eBeam 
Software, eBeam Software opens a mode selection dialog. Select  “Capture from 
Whiteboard” (Whiteboard mode), or “Use with Projector” (Projection mode), and 
click the Calibrate button. eBeam Software opens the appropriate calibration 
wizard. 

To select a mode, see the following table.

Platform Instructions

PC • The “Tools->eBeam Hardware” menu in eBeam Software’s 
Whiteboard mode application. See “Using The Whiteboard Mode 
Application” on page 18.

• The Status icon right-click menu in eBeam Software’s Whiteboard 
mode application. See “Using The Whiteboard Mode Application” on 
page 18.

• eBeam Software’s Windows taskbar menu.
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5. The first time you use projection mode you are prompted to calibrate immediately. 
Click the Calibrate button to automatically open the calibration wizard.

Manually starting a calibration is described in:

• “Using The Whiteboard Mode Application” on page 18 for Whiteboard mode.

• “Projection/Virtual Touchscreen Mode” on page 21 for Projection mode.

Whiteboard Mode

Whiteboard mode is the Quartet IdeaShare Board acting as a whiteboard recorder;
recording data as it is written on the whiteboard and displaying that data in the eBeam
Software whiteboard mode application window.

Macintosh 
OS X

• The System menu in menu in eBeam Software’s Whiteboard mode 
application. See “Using The Whiteboard Mode Application” on 
page 18.

• The Status icon menu in menu in eBeam Software’s Whiteboard 
mode application. See “Using The Whiteboard Mode Application” on 
page 18.

• The eBeam System Settings icon from the docklet. File menu.

Platform Instructions
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Using The Whiteboard Mode Application

The look and feel of the whiteboard mode application varies between the Windows and
Macintosh platforms.  The functionality remains the same.

 

Menus Allows access to all of software functions and features.

Toolbar Allows access to the most commonly used features.

Active Page Receives data written on the whiteboard.   The Active Page will 
always be the most recently created page in the meeting.

Thumbnail
View

Displays thumbnails of all pages in the meeting.

Participants
View

Displays the login names of all users connected to a meeting, as well 
as allows users to “chat” with each other using the software’s instant 
messaging system.

Web View
(PC Only)

The Web View allows access to web pages, and allows the meeting 
host to lead a Web Tour. After clicking the Web Tour button, simply 
type a web address in the Web View toolbar. 

Annotation
Tools

Palette of tools that allow the user to annotate/draw on the 
displayed meeting page using the a mouse and/or keyboard.

Play Controls Allows you to play back the meeting like a movie. The meeting is 
played forward, line by line, at varying speeds. Also, playback can 
be restricted to either the current page, or set to play all pages.

Active Page

Menus

Toolbar

Thumbnail View

Participants View

Web View

Annotation Tools

Play Controls Active
Page
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Toolbar

Annotation Tools

New Saves the active page and opens a new active page.

Duplicate Copies the selected page and makes the copy the Active Page. In 
the PC version, the new page becomes the Active Page only if the 
current Active Page is the page that is duplicated.

Delete Deletes the selected page.

Print Prints the selected page to the printer connected to your 
computer.

Full Screen Maximizes the software application window on the screen.

Share Meeting Share a meeting either over the local intranet or the Internet.

Join Meeting Allows you to log on to a meeting broadcasting over the local 
Intranet or Internet.

Status Icon The Status icon reports the connection status of eBeam Software 
to the hardware. A whiteboard icon indicates Whiteboard mode, a 
projector icon indicates Projection mode, a flipchart icon indicates 
Flipchart Mode. A grayed out icon indicates that eBeam Software 
is not connected to the hardware. See eBeam Software’s help 
system for a description of the Status Icon.

Marker Allows you to write freehand in one of four standard solid colors 
on any page. Double-click on any marker color for additional color 
choices.

Highlighter Allows you to write freehand in one of four transparent colors on 
any page. Double-click on any highlighter color for additional 
color choices.

Eraser Erases both whiteboard data and annotations from within the 
software.

Zoom Enlarges/decreases the view of the displayed page.

Text Allows you to add text annotations to a page.
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Play Controls

Pointer

(PC Only)

The Pointer tool is enabled during a shared meeting. The Pointer 
tool allows each meeting participant to point anywhere within the 
meeting window. Each participant’s pointer is displayed in a 
different color. 

The pointer direction (right, left, up, down) can be selected from 
the palette that appears when the Pointer tool is selected. You 
can also hide the pointer by clicking the “Hide Pointer” button 
from the palette that appears when the Pointer tool is selected.

Selector Allows you to draw a selection rectangle in the displayed page, 
and then copy and paste the selected area into another 
application.

Jump to
Beginning

Jumps to the very beginning of the meeting, which is always the 
original blank page.

Drag Control
Slider

Allows you to step through the meeting forward or reverse by 
clicking on the drag line, or to immediately jump to a specific 
point in the meeting by dragging the drag bar to a location on the 
drag line.

Play Replays the meeting pen stroke by pen stroke from beginning to 
end, beginning with a blank screen. While playing, the Play button 
changes to a Stop button, allowing you to stop the playback. See 
Play Speed.

Jump to End Jumps to the end of the meeting, restoring all whiteboard strokes 
and annotations.

Loop

(PC Only)

Replays the meeting from beginning to end, beginning with a 
blank screen. Once the end of the meeting is reached, the 
meeting begins to replay from the beginning. Runs continuously. 
While playing, the Play button changes to a Stop button, allowing 
you to stop the playback.

All Pages If “All Pages” is checked, then clicking “Play” causes the entire 
meeting to be played back. If “All Pages” is not checked, then 
only the currently displayed page is played back.

Play Speed Speed at which the meeting is played. 0.5x is the slowest speed 
possible, and 8.0x is the fastest speed possible.
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Projection/Virtual Touchscreen Mode

In Projection mode, the Quartet IdeaShare Board, your computer and a projector are
all used together to convert your whiteboard into a virtual touchscreen.

The Quartet IdeaShare Board and the projector plug in to your computer.  The
projector displays your computer desktop onto the whiteboard and the Quartet
IdeaShare Board detects when you touch, allowing an electronic pen (using the plastic
stylus insert) to act as a virtual mouse, controlling your computer’s desktop.

In projection mode, you can operate your computer directly from the whiteboard.  You
can open, work in, and close applications; draw freehand in painting and drawing
applications, or even operate the digital whiteboard mode application directly from the
whiteboard.

Projection mode setup is illustrated below.

Projection Mode Setup

1. Set up the Quartet IdeaShare Board as described in the Quick Set Up Guide.

2. Set up the projector, and connect to the same computer the Quartet IdeaShare 
Board is connected to.

3. Turn on your projector, and project your computer’s desktop on the whiteboard.

4. Open any electronic pen and insert the plastic stylus insert. The plastic stylus 
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insert is a plastic piece that has the same shape as a dry-erase marker, but has a 
plastic tip that does not leave marks.

5. Launch the software and switch to projection mode according to the description in 
“Software Installation & First Time Use” on page 16.

6. If this is the first time Projection Mode has been run on this computer, you will be 
prompted to calibrate. That calibration is saved. If the projector is moved at any 
time, you must recalibrate the software to retain accuracy. 

Note: In the PC version of eBeam Software, the first time you launch the 
software, eBeam Software opens a mode selection dialog. Select  “Capture from 
Whiteboard” (Whiteboard mode), or “Use with Projector” (Projection mode), and 
click the Calibrate button. eBeam Software opens the appropriate calibration 
wizard.

7. To manually open the calibration wizard for projection mode, use the following 

table.

8. You are now ready to use Projection mode.  For more detailed explanations, 
instructions, and tips on Projection mode, see eBeam Software’s help system, 
accessible through the Help menu. 

eBeam Software’s meeting application or Microsoft NetMeetingTM can be used in white-
board mode or virtual touchscreen mode to share information on the Quartet
IdeaShare Board over the intranet/Internet with remote meeting participants. Please
see the Software Reference Guide for instructions on sharing or joining meetings.

The eBeam Software Help System

eBeam Software’s Help system contains information on each software feature.  To
access help in the Whiteboard mode application, choose “Contents” from the Help
menu.

Platform Instructions

PC Click the eBeam Software icon from the Windows task bar, and 
then choose “Projection Mode>Calibrate” from the menu.

Macintosh OS X Click the eBeam System Settings icon from the Mac OS X 
docklet, then choose “Calibrate Projection Area” from the File 
menu.
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Chapter 4

Troubleshooting

Commonly encountered issues can be resolved by following the instructions below.

Please see “Website Support” on page 25, and “Additional Technical Support” on
page 25, for more information on Quartet IdeaShare support.

Troubleshooting Tips

Error Message “eBeam not found. Check connection cable and power supply.”
This message might appear at application startup, or during the course of a
meeting.

or

Status Line Message “Could not autodetect eBeam Hardware.” or “Could not
connect to eBeam Hardware on X.” (where X is a port). This message would
most likely occur when you have selected Cancel from the “eBeam not found”
message dialog.

PC Quartet IdeaShare Board - hardware

• Check that all cables are connected as shown in the Quick Set Up Guide.  Select 
Retry.

• Check that the LEDs on the tray are on. If the LEDs are not lit, this indicates 
that the hardware is not getting any power. Check that all cables are connected 
properly. Select Retry.

• Disconnect and reconnect the computers USB cable from the hardware. Select 
Retry.

• Restart the hardware.

All systems - software

• Select “eBeam Hardware>Detect eBeam Hardware” from the Tools Menu. This 
attempts to connect to the hardware according to the settings in the 
“Tools>eBeam Hardware Setup” dialog.

• If you are using a port other than COM1, COM2, or USB, you cannot use 
Autodetect. Select “eBeam Hardware>eBeam Hardware Setup” from the Tools 
Menu and specify the COM port. 

• Do you have more than one copy of the software installed on your computer? If 
so, the other copy may be running and have control of the port. Shut down the 
other copy. We recommend that old versions of the software be uninstalled from 
your computer.

• Exit the application and restart it.

• Check that the electronic eraser is not resting on the eraser pad. This might be 
causing the eraser to send a signal to the hardware continuously.
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Status Line Message “Calibration failed. Check power and cables.” This
message would most likely occur when you first launch the software, or have
selected Retry from the “eBeam not found” message dialog.

Message “The eBeam hardware is currently in projection mode. Would you
like to use the eBeam hardware for this application?” This message might
appear at Whiteboard mode application startup, after selecting “Capture from
Whiteboard”, or after selecting “Capture from Flipchart”. 

Software states that the eBeam hardware is detected, but writing does not
appear in Whiteboard mode application’s Active page.

PC /
Macintosh

Quartet IdeaShare Board - hardware

• Message displayed if the hardware is detected, but the receivers can’t “talk” to 
each other. The receiver housing is located (when facing the board) on the left 
side of the board. Check that there is nothing stuck in the receiver housing, 
such as excess packaging. Make sure nothing is interfering between the 
receivers.  Restart the system.

PC/
Macintosh

• Message displayed if you are trying to open or switch to the digital whiteboard 
application while the software is in projection mode. See “Software Installation 
& First Time Use” on page 16 for a description of how to change modes.

PC /
Macintosh

• Press the electronic pen down on the whiteboard. If you do not hear a faint 
buzzing, replace the batteries.

• Try another electronic pen. If the other electronic pen works, replace the 
batteries in the electronic pen that does not work.

• Make sure you are not holding the electronic pen too close to the tip of the 
electronic pen. This blocks the signal.

• In the Windows version of eBeam Software, select “eBeam Hardware>Detect” 
from the Tools menu, and then check the status line. If the status line states 
that eBeam is not detected, make sure that the hardware and software are set 
up properly with all cables connected, and then select “eBeam 
Hardware>Detect” from the Tools menu.

• In the Mac OS X version of eBeam Software, select “Detect” from the System 
menu, and then check the status line.  If the status line states that eBeam is not 
detected, make sure that the hardware and software are set up properly with all 
cables connected, and then select “Detect” from the System menu.
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Website Support

For additional help, consult the Support section of the Quartet IdeaShare website at
www.ideashare.com.

Additional Technical Support

If you have difficulties installing or using your Quartet IdeaShare Board, please re-
check the section of the User Guide or Quick Set Up Guide that relates to your
problem. If you are still unable to solve the problem, please contact our Customer
Service Team for assistance.

Customer Service
(800) 541-0094 USA
(800) 605-6513 Canada
contactus@gbc.com

Please have the following information ready when you contact customer service:

• Model number: 

- Quartet IdeaShare Board Q8500 (3’ x 4’)

- Quartet IdeaShare Board Q8600 (6’ x 4’).

• Date and proof of purchase.

• Operating system of your computer (Windows 98, XP, Macintosh OS 10, etc).

• Software you use with this product (eBeam Software version, PDA software, etc).
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Warranty

Limited Hardware Warranty

Quartet warrants to the original purchaser for a period of 1 year after purchase that 
this Quartet product's hardware is free from defects in work-manship and material 
under normal use and service. Quartet's obligation under this war-ranty is limited to 
replacement or repair, at Quartet's option, of any warranted part found
defective by Quartet without charge for material or labor.

THIS WARRANTY IS IN LIEU OF ALL OTHER EXPRESS WARRANTIES.  REPRESENTA-
TIONS OR PROMISES INCONSISTENT WITH, OR IN ADDITION TO, THIS WARRANTY
ARE UNAUTHORIZED AND SHALL NOT BE BINDING UPON GBC.  IN NO EVENT SHALL
GBC BE LIABLE FOR ANY SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES,
WHETHER OR NOT FORESEEABLE.  SOME STATES DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, SO THE
ABOVE EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU.

ANY IMPLIED WARRANTIES ARE LIMITED IN DURATION TO THE DURATION OF THIS
WARRANTY.  SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED
WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

This warranty shall be void if the product has been misused, damaged by negligence or
accident, or altered by anyone other than Quartet or Quartet's authorized agents.

This warranty gives you specific legal rights, and you may also have other rights which
vary from state to state.

European Union Residents Only:  this warranty does not affect the legal rights which
consumers have under applicable national legislation governing the sale of consumer
goods.





Copyright Notice

Copyright © 2003 General Binding Corporation.  All rights reserved.

Quartet and IdeaShare are trademarks of General Binding Corporation.

Copyright © 2003 Luidia, Inc. All rights reserved.

This equipment is for use with general purpose, UL-Listed personal computers.

This publication is protected by copyright, and all rights are reserved. No part of it may
be reproduced or transmitted in any form or by any means for any purpose without
express prior written consent from Quartet and Luidia, Inc., except as expressly
permitted herein. 

Information in this document is subject to change without notice and does not repre-
sent a commitment on the part of Luidia, Inc.

The software described in this publication is furnished under license and may only be
used or copied in accordance with the terms of such license. 

Protected by U.S. Patent 5,866,856. Patents pending.

Trademarks 

Quartet, Q graphic and IdeaShare are registered trademarks of General Binding Corp.

eBeam, e-Beam, eBeam Software, eBeam Mouse, eBeam Moderator, and ImagePort
are trademarks of Electronics For Imaging, Inc.

Acrobat, Adobe, and Adobe Acrobat are registered trademarks or trademarks of Adobe
Systems, Inc. in the United States and/or other countries. Microsoft, MS, NetMeeting,
Windows, and Windows NT are registered trademarks or trademarks of Microsoft Cor-
poration in the United States and/or other countries. Netscape Navigator is a regis-
tered trademark or trademark of Netscape Communications Corporation in the United
States and/or other countries. Pentium is a registered trademark or trademark of the
Intel Corporation in the United States and/or other countries. Sanford and EXPO are
registered trademarks or trademarks of Sanford Corporation in the United States and/
or other countries. All other terms and product names may be trademarks or regis-
tered trademarks of their respective owners, and are hereby acknowledged.

ELECTRONICS FOR IMAGING, INCORPORATED END-USER LICENSE AGREEMENT. YOU
SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING
THIS SOFTWARE.  IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS
AGREEMENT, DO NOT USE THE SOFTWARE.  INTALLING OR USING THE SOFTWARE
INDICATES THAT YOU AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT.

LICENSE:  Luidia, Inc. grants you a non-exclusive license to use the software 
("Software") and accompanying documentation ("Documentation") on any computer, 
provided that the Software is used only in connection with the eBeam™ product 
("Product") you have obtained, subject to the terms and restrictions set forth in this 

    Agreement.  The Software is licensed, not sold.



U

R

You may use the Software solely for your own customary business or personal pur-
poses and solely in connection with the Product.  You may permanently transfer all of
your rights under this Agreement only as part of a sale or transfer of the Product, pro-
vided you retain no copies, you transfer all of the Software and Documentation
(including all component parts, the media and printed materials, any upgrades, and
this Agreement), AND the recipient agrees to the terms of this Agreement.  If the Soft-
ware is an upgrade, any transfer must include all prior versions of the Software.

You may not make or have made, or permit to be made, any copies of the Software or
portions thereof, except as necessary for backup or archive purposes in support of
your use of the Software as permitted hereunder.  You may not copy the Documenta-
tion.  You may not attempt to alter, disassemble, decrypt or reverse engineer the Soft-
ware.  You may not lease or rent the Software.

PROPRIETARY RIGHTS:  You acknowledge that the Software and Trademarks are pro-
prietary to Luidia and its suppliers and that title and other intellectual property rights
therein remain with Luidia and its suppliers.  Except as stated above, this Agreement
does not grant you any right to patents, copyrights, trade secrets, trademarks
(whether registered or unregistered), or any other rights, franchises or licenses in
respect of the Software or Trademarks.  You may not adapt or use any trademark or
trade name which is likely to be similar to or confusing with that of Luidia or any of its
suppliers or take any other action which impairs or reduces the trademark rights of Luidia
or its suppliers.

CONFIDENTIALITY:  You agree to hold the Software in confidence, disclosing the Soft-
ware only to authorized users having a need to use the Software as permitted by this
Agreement and to take all reasonable precautions to prevent disclosure to other par-
ties.

REMEDIES AND TERMINATION:  Unauthorized use, copying or disclosure of the Soft-
ware, Trademarks or any breach of this Agreement will result in automatic termination
of this license and will make available to Luidia other legal remedies.  In the event of ter-
mination, you must destroy all copies of the Software and all of its component parts.
All provisions of this Agreement relating to disclaimers of warranties, limitation of lia-
bility, remedies, or damages, and Luidia's proprietary rights shall survive termination.

LIMITED WARRANTY AND DISCLAIMER:  Luidia warrants to the original purchaser ("Cus-
tomer") for one (1) year from the date of original purchase from Luidia or its authorized
retailer that the Software will perform in substantial conformance to the Documenta-
tion.  Luidia warrants the media containing the Software against failure during the above
warranty period.  Luidia makes no warranty or representation that the Software will meet
your specific requirements, that the operation of the Software will be uninterrupted or
error free, or that all defects in the Software will be corrected.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, LUIDIA MAKES AND YO
RECEIVE NO WARRANTIES OR CONDITIONS ON THE SOFTWARE, EXPRESS, IMPLIED,
STATUTORY, OR IN ANY OTHER PROVISION OF THIS AGREEMENT OR COMMUNICA-
TION WITH YOU, AND LUIDIA SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTY O
CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.



LIMITATION OF LIABILITY:  IN NO EVENT WILL EFI OR ITS SUPPLIERS BE LIABLE FOR
ANY DAMAGES, INCLUDING LOSS OF DATA, LOST PROFITS, COST OF COVER OR
OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING
FROM THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR FAILURE OF
THE SOFTWARE, HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY.  THIS LIMI-
TATION WILL APPLY EVEN IF EFI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.  YOU ACKNOWLEDGE THAT THE PRICE OF THE PRODUCT REFLECTS THIS
ALLOCATION OF RISK.  BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE EXCLU-
SION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES,
THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

EXPORT CONTROLS:  You agree that you will not export or re-export the Software in
any form in violation of any applicable laws or regulations of the United States or the
country in which you obtained them.

GOVERNMENT USE:  Use, duplication or disclosure of the Software by the United
States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of
the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or
in subparagraphs (c) (1) and (2) of the Commercial Computer Software-Restricted
Right Clause at 48 CFR 52.227-19, as applicable.

GENERAL: the laws of the State of California govern this Agreement.  You agree that
this Agreement shall not be subject to the United Nations Convention on Contracts for
the International Sale of Goods (1980). This Agreement is the entire agreement held
between us and supersedes any other communications or advertising with respect to
the Software.  If any provision of this Agreement is held invalid, the remainder of this
Agreement shall continue in full force and effect.
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